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Preface 
Customer Support 

 https://metalink.oracle.com  
When contacting Customer Support, please provide: 
 Product version and program/module name. 
 Functional and technical description of the problem (include business impact). 
 Detailed step-by-step instructions to recreate. 
 Exact error message received. 
 Screen shots of each step you take. 

Note: Information contained in this document may not 
match your application exactly. This is due to configuration 
changes and customizations that may have been made for the 
version that you are working with.
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1 
Introduction 

Oracle Retail ChannelPlan is part of the Oracle Retail Predictive Planning Suite. It 
provides financial location planning functions. The functions support industry planning 
standards for pre-season and in-season processes. Functions and processes that are a part 
of the ChannelPlan application include: 
 Setting Store Open and Close Dates 
 Computing store status (Comp/Non-Comp/Closed) 
 Creating a strategic location plan 
 Plan approval 
 Plan maintenance 
 Re-planning 
 Plan monitoring 

ChannelPlan role definition and security control the functions a user may perform. 
This chapter discusses a basic planning process and how it has been incorporated into the 
ChannelPlan application. The primary components of the application will be introduced 
and explained. 

About this User Guide 
This document is intended for ChannelPlan users who create, manage, and modify 
financial plans. It is a guide for understanding basic aspects of planning and how to use 
ChannelPlan. 
This user guide provides detailed information about the ChannelPlan application and 
functions and is intended as a reference in everyday work. The chapters are presented in 
an order to help you understand the application quickly; beginning with basic 
functionality and process and progressing to more advanced features. 



Introduction 

2  

About Oracle Retail Predictive Planning  
Oracle Retail Predictive Planning products are flexible applications that provide 
functionality for developing, reconciling, and approving plans. Supported by an industry 
standard process, the Oracle Retail Predictive Planning products are scalable to allow 
planning at many levels of detail, from high-level strategic planning to in-season 
financial management. 
Built on powerful predictive engines, the Oracle Retail Predictive Planning products use 
integrated demand forecasting to provide an accurate view of customer demand with little 
human intervention. Exception management functions flag affected areas of a plan that a 
user may not notice when they are managing large amounts of data. 

Process for using Oracle Retail Predictive Planning 
Products 
Oracle Retail Predictive Planning supports the planning lifecycle processes from 
including high-level strategic planning to detailed financial planning to Micro-
Merchandising. Product and Channel (specifically location) planning components are 
supported with a pre-season planning process. Product planning is also supported with an 
in-season planning process. The diagram below illustrates the business process supported 
by Oracle Retail Predictive Planning.  

  
Process supported by Oracle Retail Predictive Planning products 
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ChannelPlan Components and Key Processes 
This section introduces ChannelPlan key components and features. These provide the 
basis for standard processes and activities that are necessary for a planner to perform their 
planning functions. 
The key components introduced in this section include: 
 Workbooks – the primary element used in building a plan. A planner will use a 

workbook to build and maintain their plans throughout the season. 
 Worksheets – contained within workbooks. The worksheets are displayed in a tab 

format and contain pre-defined lists of measures. The worksheets are arranged to 
reflect a standard planning process, allowing a user to work in a logical path to build 
a plan. 

 Worksheet data – Saving, Committing, and editing plan data. 
 Plan versions – ChannelPlan is delivered with the capability to have more than one 

version of the plan. This allows you to be able to track actuals against the original 
plan, and then re-plan the current season and save to a new plan. 

For more information on application functions, see RPAS Online Help or the RPAS 11.0 
User Guide. 

Workbooks 
A ChannelPlan user accomplishes multiple planning tasks using workbooks. A workbook 
is a user-defined data subset (of a master database) that includes selected hierarchical 
dimensions. These workbooks consist of worksheets and graphical charts that are used 
for planning, viewing, and analyzing business measures. Workbooks organize related 
planning information and divide levels of user responsibility. This framework allows a 
user to easily view, create, modify, and store data sets that are common to repeated tasks.   
A workbook structure consists of the following elements: 
 Product levels and members ─ for example, Department, Class, Sub-Class for 

Men’s Sweater Department might be used for a Product Plan. ChannelPlan uses the 
total Company level for Product. 

 Time levels and members ─ for example, Season, Month, Week for Spring 2004 
Season. 

 Location levels and members ─ for example, these members may reflect multiple 
channels within an organization at their aggregate level; such as total Brick & Mortar 
divisions, Catalog and /or e-Commerce. In the ChannelPlan workbooks, the members 
might be Region, District, Store for North America- East Coast. 

 Plan versions ─ for example, Working Plan (Wp), Original Plan (Op), Current Plan 
(Cp), and, Last Year (Ly). 

 Measures and corresponding business rules ─ for example, Sales, Receipts, 
Markdowns, Inventory. 

For more on Product, Time, and Location hierarchies; see RPAS Online Help or the 
RPAS 11.0 User Guide. 
Workbooks can be built automatically, via a batch process, or manually using the 
Planning Workbook wizard. Each workbook contains the planning windows, measures, 
and business rules needed for a complete plan.  
Data in a workbook can be displayed using both multi-dimensional spreadsheets and 
charts. The data can be viewed at a detailed level or at an aggregate level. 
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For descriptions of the Oracle Retail ChannelPlan workbooks, see the remaining chapters 
of this user guide. For more information on manipulating data in the worksheets, see 
RPAS Online Help or the RPAS 11.0 User Guide. 

Worksheets 
Planning worksheets are multi-dimensional spreadsheets that provide you with views of 
the data contained in a workbook. Oracle Retail Predictive Planning comes with a series 
of built-in worksheets that support an industry standard business process. Each worksheet 
can contain its own unique product, time, and metric information. This approach enables 
users across an organization to use a standard planning process. 
Worksheets can be customized for each user. Rotating, pivoting, and format functions 
allow you to create individual views within a worksheet. Each user may also display the 
data in a graphical format by using the charting function. 
For descriptions of the Oracle Retail ChannelPlan worksheets, see Chapter 2. For more 
information on manipulating data in the worksheets, see RPAS Online Help or the RPAS 
11.0 User Guide. 

Editing Worksheet Data 
You may edit data at many levels of each hierarchy (product, location, time). If the data 
is modified at an aggregate level (a level with one or more lower levels beneath it), the 
modifications are distributed to the detailed levels within the department. This function is 
called spreading. If data is modified at a level that has a higher level above it (parent), the 
data changes are reflected in those higher levels. This is known as aggregation.  
You will use the worksheets to edit and enter data. The application’s business rules are 
implemented throughout the worksheets to ensure consistent edit behavior regardless of 
where (on which worksheet) the edit it performed. 

Measure Aggregation and Spreading 
Each measure that is used in the Channelplan solution is assigned a default aggregation 
and spreading behavior. A measure’s aggregation method controls how data is calculated 
at aggregate levels of the hierarchy, such as month or department. A measure’s spread 
method controls how data is spread to lower levels of a hierarchy when you enter data at 
an aggregate level. The aggregation and spread methods that are used in ChannelPlan are 
described in the following tables. 

Aggregation Methods 

Aggregation 
(Agg) 
Methods 

Result Types of Measures 

Total Values are summed up the hierarchy 
dimensions. 

Value or Unit measures such as 
Sales, Markdowns, and 
Receipts. 

Recalc Value is recalculated at aggregate 
levels based on its rule calculation.  

% measures such as GM R %, 
Markdown %, Customer 
Returns  %; also other 
calculated measures such as 
TO, Forward Cover. 
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Aggregation 
(Agg) 
Methods 

Result Types of Measures 

PST – Period 
Start Total 

Value is summed up non-calendar 
hierarchies. Value at aggregate time 
equals the same value as the 1st child 
period’s value belonging to the 
aggregate parent. 

Beginning of Period Inventory 
(BOP). 

PET – Period 
End Total 

Value is summed up non-calendar 
hierarchies. Value at aggregate time 
equals the same value as the last child 
period’s value belonging to the 
aggregate parent. 

End of Period Inventory (EOP).

AMBG All values within and across 
hierarchies are equal otherwise a “?” 
is displayed at aggregate levels. 

Used by informational text 
measures such as “Event 
Information” or pick list 
“Approve/Reject.” 

B_AND For Boolean types only referring to 
situations that are either “true” or 
“false.” Value is “on” or “true” at an 
aggregate level if all values within a 
hierarchy level are “on.” 

Boolean (check box) “Submit.” 
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Spread Methods 

Spread 
Methods 

Result Types of measures 

Proportional Typically used in conjunction with 
Total Agg Type. 
Value is spread proportionally to the 
child dimensions when a value is 
entered at an aggregate level. 

Value or Unit measures such as 
Sales, Markdowns, and 
Receipts. 

None The result of the edit is passed to 
another measure. The spread method 
for the measure that inherits the edit 
is used to spread the new value to the 
child dimensions. For example, an 
edit to Wp Sales var Ly R% at an 
aggregate level (Month) results first 
in the Sales R value being 
recalculated at the Month level, 
reflecting the edited percent increase 
over Ly Sales R; then the new Sales 
R value is spread to the week level 
proportionally. Finally, the Wp Sales 
var to LY R% is recalculated at the 
week level. 

Variance measures such as Wp 
Sales var to Ly R%, Wp Mkd 
var to Op R%. 

PS (Period 
Start) 

For edits at an aggregate level, the 
edited value is placed into the first 
logical child dimension beneath the 
level of the edit. For example, an edit 
to BOP Inv at the Month level will 
spread the edited BOP Inv value to 
the first week reporting to the Month. 

 

PE (Period 
End) 

For edits at an aggregate level, the 
edited value is placed into the last 
logical child dimension beneath the 
level of the edit. For example, an edit 
to EOP Inv at the Month level will 
spread the edited EOP Inv value to 
the last week reporting to the Month. 

Typically used in conjunction 
with EOP Inv, Avg Inv. 

When editing cells at an aggregate hierarchy level, the default spread method for a 
measure can be overridden by typing a numeric value into the cell followed by an “r” 
(replicate), “e” (even), “d” (delta) or “p” (proportional).   
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Overriding Default Spread Methods 
A measure’s default spread method can be overridden on a data entry by using the 
override spread method function. The default spread method is overridden for that 
specific data edit and is not permanently changed. To use an alternate spread method, 
enter a number in a data cell at an aggregate level followed by an r, e, p, or d. This will 
apply the Replicate, Even, Proportional, or Delta distribution function to spread that 
number to the lowest level. 

Note: Save information in the workbook before trying these 
features. If you are not comfortable with the results, simply 
use the Edit > Revert command to undo the changes. The 
Revert command will reset the workbook back to its state 
after that last SAVE was issued. 

Explanation of Spread Types 
Assume the following hierarchy and values are in place: 

 February Week1 Week2 Week3 Week4 

Department1 570 155 170 100 145 

Class1 120 20 20 40 40 

Class2 100 25 25 25 25 

Class3 200 100 50 20 30 

Class4 150 10 75 15 50 

 Replicate – Copies the entered value to all cells below the aggregate dimension.  
This method can be used for measures that have an aggregation method of Total or 
Recalc. 

If a value is entered at more than one aggregate dimension (such as aggregate product 
and time), the value is copied to ALL lower-level base cells below the aggregate time 
and product. 
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Example:  
Enter 50r for Feb/Department1, the values at every intersection of week and class 
belonging to Feb/Department1 are changed to 50. The aggregate total is then 
recalculated as the sum of the lower-level cells, 800. See results below. 

 February Week1 Week2 Week3 Week4 

Department1 800 200 200 200 200 

Class1 200 50 50 50 50 

Class2 200 50 50 50 50 

Class3 200 50 50 50 50 

Class4 200 50 50 50 50 

 Even – Divides the entered value evenly to all cells below the aggregate dimension.  
This method can be used for measures that have an aggregation method of Total or 
Recalc.   

If a value is entered at more than one aggregate dimension (such as aggregate product 
and time), the value is copied to ALL lower-level base cells below the aggregate time 
and product. 

Example:   
Enter 600e for Feb/Department1, the value at every intersection of week and class 
belonging to Feb/Department1 changes to 37.5. The aggregate total is then 
recalculated as the sum of the lower-level cells, 600. See results below 

 February Week1 Week2 Week3 Week4 

Department1 600 150 150 150 150 

Class1 150 37.5 37.5 37.5 37.5 

Class2 150 37.5 37.5 37.5 37.5 

Class3 150 37.5 37.5 37.5 37.5 

Class4 150 37.5 37.5 37.5 37.5 

 Proportional – Spread the difference between the original and entered value to all 
cells below the aggregate dimension based on that cell’s percent contribution to the 
original value in the edited cell. This method can be used for value or unit measures 
that have an aggregation method of Total. 

If a value is entered at more than one aggregate dimension (such as aggregate product 
and time), the value is copied to ALL lower-level base cells below the aggregate time 
and product. 
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Example:   
Enter 1140p for Feb/Department1, the value for every intersection of week and class 
belonging to Feb/Department1 doubles (the % contribution of the base cell to the 
aggregate remains unchanged). See results below. 

 February Week1 Week2 Week3 Week4 

Department1 1140 310 340 200 290 

Class1 240 40 40 80 80 

Class2 200 50 50 50 50 

Class3 400 200 100 40 60 

Class4 300 20 150 30 100 

 Delta – Spread the difference between the original and entered value evenly to all 
cells below the aggregate dimension. This method can be used for value or unit 
measures that have an aggregation method of Total. 

If a value is entered at more than one aggregate dimension (such as aggregate product 
and time), the value is copied to ALL lower-level base cells below the aggregate time 
and product. 
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Example:   
Enter 670p for Feb/Department1, the value for every intersection of week and class 
belonging to Feb/Department1 increases by the same value, 100/16 or 6.25. 

 February Week1 Week2 Week3 Week4 

Department1 670 155 170 100 145 

Class1 120 26.25 26.25 46.25 46.25 

Class2 100 31.25 31.25 31.25 31.25 

Class3 200 106.25 56.25 26.25 36.25 

Class4 150 16.25 81.25 21.25 56.25 

Saving Worksheet Data 
Two options are available to ensure that data is saved during the planning process.   
 Save – Data is saved to a user database and does not affect the master database. This 

allows you to manipulate details and evaluate the impact of the changes without 
changing the master data.  Any data saved via the Save option is saved to a local 
copy of the database (usually your computer or network folder). Other users are not 
able to view the saved data by default. You may save the workbook with “global 
access” enabling others to view your local workbook. 

 Commit – Date is saved to the master database. Data (including changed) is 
accessible to all users once their workbooks are rebuilt or refreshed.   

There are two methods for retrieving updated data from the master database to a local 
workbook: 
 Refresh – You can use the Refresh option to retrieve data from the master database 

to an existing workbook. A user may retrieve data for all measures in a workbook or 
select specific measures. 

 Build – You may build a new workbook manually. As an alternative for building a 
workbook manually, a ChannelPlan administrator can run a batch process (delivered 
with ChannelPlan) to automatically build a new workbook. 

For more information about editing data, saving changes, aggregation, and spreading, see 
RPAS Online Help or the RPAS 11.0 User Guide. 
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Planning Roles 
Planning roles serve these purposes: 
 They identify the organizational level at which planning occurs.  
 They set the product level at which that role will plan. 
 They set the time period at which that role will plan. 

The base intersection is a ChannelPlan term that defines the lowest level of time and 
product to which that role will have access to for their plan. The planning role defines the 
range of planning responsibilities and affects the measures shown in planning worksheets 
and the access permissions to those measures. 
While the planning roles can be customized during implementation, a standard planning 
role is supplied with ChannelPlan:  
Channel Planner (Ch)  
The range of planning and the role relationships for these roles are as follows:  

Role Base 
intersection 

Range of 
planning 

Lowest-level 
time period 

Channel Planner 
(Ch) 

Store/Week Channel- 
Store 

Week 

Plan Versions 
The financial planning processes supported by ChannelPlan use plan versions to 
designate different plan types that are used throughout the planning horizon. These 
version names and their abbreviations are used frequently in planning worksheets (for 
example, to distinguish measures). 
The plan versions that are available to ChannelPlan users are as follows: 

Plan version Channel 
Planner 

Working Plan (Wp) X 

Last Year (Ly) X 

Forecast (Fcst) X 

Original Plan (Op) X 

Current Plan (Cp) X 

The following sections describe each plan version. 

Working Plan (Wp) 
The plan version that is editable for a particular pre-season or in-season period. This plan 
version is used to develop and revise plans. 
This plan version is used to develop and revise plan data. 
For In-Season workbooks, the Wp version contains actual data values for the elapsed 
time periods for the season. 
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Last Year (Ly)  
A plan version that provides a reference to last year’s actual data.  

Forecast (Fcst)  
A plan version that provides a reference to the sales forecast. It is automatically generated 
and updated from Oracle Retail Demand Forecasting (RDF). 

Original Plan (Op) 
A pre-season plan that has been self-approved and promoted from Working Plan (Wp) to 
Original Plan (Op) version.  

Current Plan (Cp) 
An in-season plan that has been self-approved and promoted from Working Plan (Wp) to 
Current Plan (Cp) version.  
The Cp version contains actual data values for the elapsed time periods in-season. 

Plan Self-Approval  
In ChannelPlan, the planner uses the Approval worksheet to self-approve their plan to 
and create the Original Plan (Pre-Season) or the Current Plan (In-Season).   
The self-approve functionality is available through a custom menu, ChannelPlan. Under 
this menu, the “Self-Approve” option moves the data from Wp to either Op or Cp 
depending on whether the user is using the Pre-Season or In-Season Template. This 
process also automatically commits the data to the database. 
For more about plan approval, see “Self Approval worksheet” in Chapter 2. 
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Alternate Hierarchies 
When Oracle Retail Predictive Solutions are installed, implementation scripts define the 
dimensions and hierarchical structures specific to your organization. For example, the 
system can be built to recognize that weeks roll up into months, that months roll up into 
quarters. The following diagram shows standard time hierarchy: 

Week 1 Week 2 Week 3 Week 4

Month 1 Month 2

Week 5

Quarter

Month 3

Week 9

 
A Standard Time Hierarchy 

However, it may be necessary to define time periods based on an alternate roll-up design 
to suit a particular business need. Arbitrary periods in the time hierarchy can be grouped 
together for use in functions such as planning, forecasting, and measure analysis. These 
user-defined groupings act as normal dimensional levels; that is, they allow data 
aggregation from the lower to the higher levels of the hierarchy and allow spreading from 
the higher to the lower levels of the hierarchy.  For example, an Easter holiday period 
may consist of two weeks of February and two weeks of March.   
Another example is a dimension (in this case called Holiday) made up of specific weeks 
surrounding all the holiday periods in the year. In the diagram below, the alternate time 
hierarchy, Holiday consists of Week 4, Week 5, and Week 9. When the Holiday time 
period is displayed in a workbook, you will see these three weeks displayed once the 
Holiday period is expanded. You can see the total Holiday measures (such as total 
Holiday sales), as well as be able to drill-down to the specific weeks within Holiday to 
see if any one particular week performed better than the others. 
For more information about creating Alternate Hierarchies, see RPAS Online Help or the 
RPAS 11.0 User Guide. 
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Printing and Reporting 
ChannelPlan users can print planned data at any time using the File> Print option. This 
option will print the current worksheet and any measures listed on it. 
If reporting requirements dictate more sophisticated reports, Oracle Retail Data 
Warehouse (RDW) provides the added benefit. ChannelPlan data is designed to be 
interfaced to RDW for storage and reporting purposes. Once Original and Current plans 
are approved, those figures are sent to RDW for analysis and reporting.   

Exception Management - Alerts and Exceptions 
Alerts are automatic notifications that the values of a specified metric either fall outside 
of an acceptable range or do not match a given value. Alerts are generated to let you 
know that a measure may need to be examined and possibly amended in a workbook. 
Alerts are used to automatically identify predefined issues and opportunities within your 
business and to notify members of your business when these issues and opportunities 
occur. By setting alert parameters intelligently, you ensure that opportunities and issues 
that might normally go unrealized or unresolved are quickly identified. 

Alerts 
The alert capability in ChannelPlan highlights specific conditions to a user. These 
conditions are built using the Alert Manager. The conditions (or alerts) consist of a 
business measure (the data to be analyzed) and a mathematical rule (the rule for 
determining the alert). These conditions often are used to direct users to exceptions or 
targets including OTB opportunities, stock outages, sales performance against a plan, and 
margin opportunities. 
A background program called the Alert Finder processes the alerts in a batch mode and 
finds the areas of a plan that fall outside the thresholds declared by the alert. This will 
create a message, or alert, that is flagged through the Alert Manager window. You can 
then go directly to the alerted areas of the workbook and perform the appropriate action.  
The Alert Manager is more sophisticated than simple exception reporting, as it directs 
you to the specific area of the plan that requires attention. 
For more information about creating Alerts, see RPAS Online Help or the RPAS 11.0 
User Guide. 

Exceptions 
You also have the ability to set a user-defined exception on any measure within their plan 
workbook. A user-defined exception consists an upper and lower boundary and a text 
format for each. The exception is designed to allow you to assign special formatting to be 
applied in the event the measure value falls outside one of the two boundaries. You may 
set different formats for the upper and lower boundary values. The exception is displayed 
on the worksheet when the data meets the exception criteria. 
For more information about alerts and exceptions, see the see RPAS Online Help or the 
RPAS 11.0 User Guide. 
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ChannelPlan Administration  
The ChannelPlan Administration workbook contains a single worksheet to allow the 
administrator to set a store’s status that will be used in the calculation of certain planning 
measures. This worksheet will also allow the administrator to enter the store’s open and 
close dates and the store’s total square footage. Access to the Administration workbook is 
restricted to system administrators. Planning users can view the values of theses measures 
in the planning workbooks, but cannot change their values.   

Measures 
The ChannelPlan Administration worksheet includes the following measures: 

Measure Measure Description Access

Ly Comp Store Count Last year’s number of Comp Stores Read 

Ly Non-Comp Store 
Count 

Last year’s number of Non-Comp Stores Read 

Ly Square Footage Last year’s Square Footage applicable to a 
channel hierarchy member 

Read 

Ly Store Status Indicates last year’s Comp or Non-Comp 
Status of a Store 

Read 

Wp Comp Store Count Number of Comp Stores Read 

Wp Non-Comp Store 
Count 

Number of Non-Comp Stores Read 

Wp Square Footage Square Footage applicable to a channel 
hierarchy member 

Write 

Wp Store Close Date The date a store is closed Write 

Wp Store Open Date The date a store is open for business Write 

Wp Store Status Indicates the Comp or Non-Comp Status 
of a Store 

Write 
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Location Planning  

Channel planning is a process for planning retail sales and average inventory by 
individual stores or channels. Sales values can be planned by using comparable and non-
comparable store data in addition to planning percent variances to historical data (Ly), 
product plan data and the projected demand forecast (Fcst). Average inventory is derived 
through the input of a turnover measure with displays data for sales per square feet. You 
can reconcile the aggregated level of total chain to the aggregated level of product total 
company. 
Channel/Location planners use the Pre-Season and In-Season Plan workbooks to develop 
their location plans. Once the plans are complete, the planner self-approves the plan to 
create the Original Plan (Op) or to update the Current Plan (Cp) if In-Season. The 
original/current plan values provide a foundation for comparing actual data or as a 
reference for next year’s plans. 
The following diagram shows the steps in the Location Planning process: 

Plan Store Sales
Plan Comp/Non-

Comp Store
Sales

Seed plan with
Actual and

Forecast data

Seeded
PreSeason

plan available
for use

Approved Plan
(Original Plan)

Review Store
Avg Inv & Density

Reconcile to
Financial Plan

(TopPlan)
(optional)

Location Planning
Workflow Process  (Pre-Season)

ChannelPlan on-line process

Self-Approve
Plan

 
The Executive Role in the Strategic Planning Process 
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ChannelPlan Pre-Season Workbook 
The ChannelPlan Pre-Season workbook contains the following worksheets: 
 Store Sales 
 Comp – Non Comp Sales 
 Density 
 Reconcile 
 Self-Approval 

Assumptions 
 The Working Plan version is automatically updated with Actual data for elapsed time 

periods and cannot be changed. 
 If a value or variance is changed at a time level that includes historical data (Actual), 

the data in the Actual time periods will not change. The aggregate changed value will 
be spread/replicated to non-elapsed time only. 

Store Sales Worksheet 
The Store Sales worksheet is used to plan sales for each location. Sales analysis measures 
such as variance to LY and variance to forecasted demand are available to facilitate sales 
location planning. 

Measures  
The Store Sales worksheet contains the following measures. For descriptions of these 
measures, see Chapter 4 – ChannelPlan measure list. 

Measure Access Results 

FrcPr Demand R Read  

Wp Sales var Demand 
Pre-Season R % 

Write Sales R changes based on the % var entered 

Wp Sales R Write Sales Contribution to Time R %, Sales 
Contribution to Location R %, Sales var 
Demand Pre-Season R %, Sales var LY R% 
recalculate based on the new Sales R value 

Ly Sales R Read  

Wp Sales var Ly R % Read Sales R changes based on the % var entered 

Wp Sales Contribution 
to Time R % 

Read Recalculates with a change to Sales R 

Ly Sales Contribution to 
Time R % 

Read  

Wp Sales Contribution 
to Location R % 

Read Recalculates with a change to Sales R 
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Measure Access Results 

Ly Sales Contribution to 
Location R % 

Read  

Comp – Non-Comp Sales Worksheet 
The Comp-Non-Comp Sales worksheet is used to plan and analyze sales for each 
location. The comp and non-comp sales measures are calculated on this worksheet based 
on the value of the individual store’s status. Sales analysis measures such as variance to 
LY and variance to forecasted demand are available to facilitate sales location planning. 

Usage Notes 
 A store’s comp or non-comp status is set via the ChannelPlan administration 

workbook. The store’s status is set manually by the administrator and does not have 
any relationship to the store’s open or close date. 

 You may plan Wp Sales R for any location. The measures Wp Comp Store Sales and 
Wp Non-Comp store sales are calculated based on the value of the store’s status flag 
and the value of the Sales R measure for that store. You do not plan Comp and Non-
Comp Sales directly. 

 Closed Store Sales – A store is assigned a status of either closed, comp, or non-comp.  
The measures comp sales and non-comp sales are calculated based on the store’s 
status and taking the value in Sales R. If you edit Sales R at an aggregate location, 
and the Sales R value is spread proportionally to the locations in that aggregate, and 
comp and non-comp sales are recalculated. If you enter a value in Sales R at an 
aggregate location, and the Sales R for all “child” locations are 0, the value will 
spread evenly to all stores even though some of those stores may have the status of 
“Closed.” With a portion of the sales being spread to “Closed” stores, the values of 
Comp and Non Comp Sales will not equal Sales R at the aggregate levels. You may 
edit the Closed Store Sales measure to remove any sales associated with a closed 
store. 

Measures  

Measure Access Result 

Ly Avg Store Sales R Read  

Ly Comp Store Count Read  

Ly Comp Store Sales R Read  

Ly Non-Comp Store 
Count 

Read  

Ly Non-Comp Store Sales 
R 

Read  

Ly Sales Contribution to 
Location R % 

Read  

Ly Sales R Read  
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Measure Access Result 

Ly Store Count Read  

Wp Avg Store Sales R Read Recalculates with a change to Wp Sales R or 
Store Count 

Wp Comp Store Count Read Changed via ChannelPlan Administration 
workbook 

Wp Comp Store Sales 
Base R 

Read Is recalculated if a store’s status changes from 
Comp to Closed or Non-Comp 

Wp Comp Store Sales R Read Recalculates with a change to Wp Sales R (if 
there are stores with comp status) 

Wp Comp Store Sales var 
Ly R % 

Read Recalculates with a change to Comp Store 
Sales R 

Wp Non-Comp Store 
Count 

Read Changed via ChannelPlan Administration 
workbook 

Wp Non-Comp Store 
Sales R 

Read Recalculates with a change to Wp Sales R (if 
there are stores with non-comp status) 

Wp Sales Contribution to 
Location R % 

Read Recalculates with a change to Sales R 

Wp Sales R Write Wp Comp Store Sales R if there are stores with 
comp status 
Wp Non-Comp Store Sales R if there are 
stores with non-comp status 
Wp Closed Store Sales if there are closed 
stores AND both comp and non-comp sales 
were 0 prior to edit to Sales R 
Wp Sales Contribution to Location R %, Wp 
Sales Contribution to Time 

Wp Store Count Read Changed via ChannelPlan Administration 
workbook 

Wp Store Close Date Read Changed via ChannelPlan Administration 
workbook 

Wp Store Open Date Read Changed via ChannelPlan Administration 
workbook 

Wp Store Status Read Changed via ChannelPlan Administration 
workbook 
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Density Worksheet 
The Density worksheet is used to plan and analyze sales that incorporate square footage 
information for each location. Square footage measures and sales per square footage are 
provided to assist in planning sales by location. 

Usage Notes 
 Square footage is available for each location (by week) for All Product. It is entered 

via the ChannelPlan Administration workbook. 
 Square footage is aggregated using the PET (period end total) aggregation method. 
 Average square footage is calculated at the aggregate location level based on the 

number of location dimensions belonging to the aggregate. 

Measures 

Measure Access Result 

Ly Avg Inv R Read  

Ly Avg Square Footage Read  

Ly Avg Store Sales R Read  

Ly Sales per Square 
Foot R 

Read  

Ly Sales R Read  

Ly Square Footage Read  

Ly Store Count Read  

Ly TO R Read  

Wp Avg Inv R Read Recalculates with a change to Sales R or TO 

Wp Avg Square Footage Read Recalculates with a change to Square Footage 
which is set in the ChannelPlan Administration 
workbook 

Wp Avg Store Sales R Read Recalculates with a change to Store Count or 
Sales R 

Wp Avg Inv var Ly R % Read Recalculates with a change to Avg Inv R 

Wp Sales per Square 
Foot R 

Read Recalculates with a change to Sales R or 
Square Footage 

Wp Sales R Write Recalculates Sales per Square Foot R, Avg 
Store Sales R, Avg Inv R, TO R 

Wp Store Count Read Set via the ChannelPlan Administration 
workbook 
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Measure Access Result 

Wp TO R Write Changes Avg Inv R 
When entered at aggregate time periods, use 
the ‘over-ride spread method’ “e” for even 
along with the value entered (for example,  
- “2.0e”  to spread a TurnOver value to each 
time period) 

Wp Square Footage U Read Set via the ChannelPlan Administration 
workbook 
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Reconcile Worksheet 
You may use this worksheet to compare working plan values to targets passed from 
TopPlan (financial planning) if applicable. If TopPlan is not being used, use this tab to 
compare the working plan to last year, or to current approved plan (the Op). 

Measures 

Measure Access Result 

Ly Avg Inv R Read  

Ly Comp Store Sales R Read  

Ly Non-Comp Store 
Sales R 

Read  

Ly Sales R Read  

Ly TO R Read  

Wp Avg Inv R Read Recalculates with a change to Sales R 

Wp Avg Inv var Tgt R 
% 

Read Recalculates with a change to Avg Inv R 

Wp Comp Store Sales R Read Recalculates with a change to Wp Sales R (if 
there are stores with comp status) 

Wp Non-Comp Store 
Sales R 

Read Recalculates with a change to Wp Sales R (if 
there are stores with comp status) 

Wp Sales per Square 
Foot R 

Read Recalculates with a change to Wp Sales R or 
Square Footage 

Wp Sales R Write Wp Comp Store Sales R if there are stores with 
comp status 
Wp Non-Comp Store Sales R if there are 
stores with non-comp status 
Wp Closed Store Sales if there are closed 
stores AND both comp and non-comp sales 
were 0 prior to edit to Sales R 
Wp Sales Contribution to Location R %, Wp 
Sales Contribution to Time 

Wp Sales var Tgt R % Read Recalculates with a change to Sales R or Mg 
Tgt Sales R (TopPlan Sales) 

Wp Store Count Read Changed via ChannelPlan Administration 
workbook 

Wp Square Footage Read Changed via ChannelPlan Administration 
workbook 

Wp TO R Write Recalculates Avg Inv R 

Wp Square Footage U Read Changed via ChannelPlan Administration 
workbook 
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Measure Access Result 

TMg Tgt Avg Inv R Read Updated when TopPlan Manager role passes 
targets to the TopPlan Planner role 

TMg Tgt Sales Read Updated when TopPlan Manager role passes 
targets to the TopPlan Planner role 

TMg Tgt TO R Read Updated when TopPlan Manager role passes 
targets to the TopPlan Planner role 

Self-Approval Worksheet 
This worksheet contains the measures the Channel Planner uses to self-approve their 
working plan to the approved plan, “Original Plan.” 

Steps for Self-Approving the Plan 
1. Mark the “Self Approve” checkbox for the time periods, products, and locations for 

which targets should be published, press Calculate. Checking a box at an aggregate 
time or product will mark the boxes for the lower level dimensions. 

2. Navigate to the ChannelPlan menu (located to the left of the Window menu); select 
the “Self Approve” option in the TopPlan menu. 

A message box is displayed that indicates the rule groups have executed successfully. 
If the message box indicates “success” then the approval process completed 
successfully. 

Data is automatically committed to the database and the workbook is refreshed. The 
workbook is not automatically saved. 

Measures 

Measure Access Result 

Self Approve Comment Write Value is stored until changed with the next 
self-approval process 

Wp Self Approve Write Plan values move to Op and Cp (Pre-Season) 
or Cp (In-Season) for the locations and time 
periods where the self-approve field is checked

Wp Self Approve Date Read Automatically populated with system date and 
time when the plan self-approves successfully 
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ChannelPlan In-Season Workbook 
Once the selling period begins, use the In-Season Planning worksheets to review progress 
against the plan and make adjustments to the plan.  
The worksheets in this workbook include measures that show how the selling season is 
performing relative to plan. This workbook includes all worksheets that are part of the 
Pre-Season workbook. 
Two plan versions are updated with data as during the In-Season Planning process, the 
Working Plan, and the Current Plan version. Working Plan (Wp) is updated weekly with 
Actual data. A regenerated demand sales forecast (Fcst) is updated to take into account 
the loaded actuals. Using the loaded data and the current plan, you may adjust the 
Working plan measures for future time periods. When the new plan is self-approved, the 
Current Plan (Cp) measures are updated with the changed data. The Original Plan 
approved during the Pre-Season planning process is never changed. 
The Channel Planner In-Season workbook is used to set up, adjust, reconcile, and 
approve an in-season financial plan.  
The In-Season workbook contains the following worksheets: 
 Store Sales 
 Comp/Non-Comp Sales 
 Density 
 Reconcile 
 Self-Approval 

Assumptions 
 The In-Season plan is automatically seeded with Current Plan data.   
 The Working Plan and Current Plan versions are automatically updated with Actual 

data for elapsed time periods and cannot be changed. 
 Current Plan values cannot be changed directly on the worksheet. Current Plan is 

updated when the Working Plan is self-approved. 
 If a value or variance is changed at a time level that includes historical data (Actual), 

the data in the Actual time periods will not change. The aggregate changed value will 
be spread/replicated to non-elapsed time only. 
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Store Sales Worksheet 
Use the Store Sales worksheet to plan sales by store. This worksheet provides you with a 
snapshot of the current state of many of the key. 

Measures 
The Review Trend worksheet contains the following measures. See the measure list for 
Store Sales Pre-Season worksheet or the ChannelPlan Measure List for a description of 
the measure and its calculation. 

Measure Access 

Cp Sales Contribution to Location R % Read 

Cp Sales Contribution to Time R % Read 

Cp Sales R Read 

FrcPr Demand R Read 

Ly Sales Contribution to Location R % Read 

Ly Sales Contribution to Time R % Read 

Ly Sales R Read 

Wp Sales Contribution to Location R % Read 

Wp Sales Contribution to Time R % Read 

Wp Sales R Read 

Wp Sales var Demand Pre-Season R % Write 

Wp Sales var Ly R % Read 

Comp – Non-Comp Sales Worksheet 
You may use the Comp-Non-Comp Sales worksheet to plan sales by store, and view the 
breakdown between Comp and Non-Comp Sales. A store’s comp or non-comp status is 
set via the ChannelPlan administration workbook. Store status cannot be changed on this 
worksheet. A store’s status may be changed during the planning cycle and the comp or 
non-comp sales value will recalculate. You must perform a refresh to reload any changes 
to a store’s status once the workbook is built. 
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Measures 
The Comp-Non-Comp Sales worksheet contains the following measures. See the measure 
list for Comp-Non-Comp Sales Pre-Season worksheet or the ChannelPlan Measure List 
for a description of the measure and its calculation. 

Measure Access 

Cp Avg Store Sales R Read 

Cp Comp Store Sales Base R Read 

Cp Comp Store Sales R Read 

Cp Non-Comp Store Sales R Read 

Cp Sales R Read 

Ly Avg Store Sales R Read 

Ly Comp Store Count Read 

Ly Comp Store Sales R Read 

Ly Non-Comp Store Count Read 

Ly Non-Comp Store Sales R Read 

Ly Sales Contribution to Location R % Read 

Ly Sales R Read 

Ly Store Count Read 

Wp Avg Store Sales R Read 

Wp Comp Store Count Read 

Wp Comp Store Sales Base R Read 

Wp Comp Store Sales R Write 

Wp Comp Store Sales var Ly R % Write 

Wp Non-Comp Store Count Read 

Wp Non-Comp Store Sales R Write 

Wp Sales Contribution to Location R % Write 

Wp Sales R Write 

Wp Store Count Read 

Wp Store Close Date Read 

Wp Store Open Date  Read 

Wp Store Status  
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Density Worksheet 
The Density worksheet is used to review and analyze sales that incorporate square 
footage information for each location. Square footage measures and sales per square 
footage are provided to assist in planning sales by location. 

Measures 
The Density worksheet contains the following measures. See the measure list for Density 
Pre-Season worksheet or the ChannelPlan Measure List for a description of the measure 
and its calculation. 

Measure Access 

Cp Avg Inv R Read 

Cp Avg Store Sales R Read 

Cp Sales per Square Foot R Read 

Cp Sales R Read 

Cp Square Footage Read 

Cp Store Count Read 

Cp TO R Read 

Ly Avg Inv R Read 

Ly Avg Square Footage Read 

Ly Avg Store Sales R Read 

Ly Sales per Square Foot R Read 

Ly Sales R Read 

Ly Square Footage Read 

Ly Store Count Read 

Ly TO R Read 

Wp Avg Inv R Read 

Wp Avg Square Footage Read 

Wp Avg Store Sales R Read 

Wp Avg Inv var Ly R % Read 

Wp Sales per Square Foot R Read 

Wp Sales R Write 

Wp Store Count Read 

Wp TO R Write 

Wp Square Footage U Read 
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Reconcile Worksheet 
You may use this worksheet to compare working and original plan values to targets 
passed from TopPlan (financial planning) if applicable. If TopPlan is not being used, use 
this tab to compare the working plan to last year, or to current approved plan (the Op). 

Measures 
The Reconcile worksheet contains the following measures. See the measure list for 
Reconcile Pre-Season worksheet or the ChannelPlan Measure List for a description of the 
measure and its calculation. 

Measure Access 

Ly Avg Inv R Read 

Ly Comp Store Sales R Read 

Ly Non-Comp Store Sales R Read 

Ly Sales R Read 

Ly TO R Read 

Op Avg Inv R Read 

Op Avg Square Footage Read 

Op Avg Store Sales R Read 

Op Comp Store Sales R Write 

Op Non-Comp Store Sales R Write 

Op Sales per Square Foot R Read 

Op Sales R Write 

Op Square Footage Read 

Op Store Count Read 

Op TO R Write 

Wp Avg Inv R Read 

Wp Avg Inv var Tgt R % Read 

Wp Comp Store Sales R Write 

Wp Non-Comp Store Sales R Write 

Wp Sales per Square Foot R Read 

Wp Sales R Write 

Wp Sales var Tgt R % Write 

Wp Store Count Read 

Wp Square Footage Read 

Wp TO R Write 
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Measure Access 

Wp Square Footage U Read 

TMg Op Tgt Avg Inv R Read 

TMg Op Tgt Sales Read 

TMg Op Tgt TO R Read 

Self-Approval Worksheet 
This worksheet contains the measures the Channel Planner uses to self-approve their 
working plan to the approved plan, “Current Plan.” 

Steps for Self-Approving the Plan 
1. Mark the “Self Approve” checkbox for the time periods, products, and locations for 

which targets should be published, press Calculate. Checking a box at an aggregate 
time or product will mark the boxes for the lower level dimensions.   

Note: Only non-elapsed time is available for self-approving.  
Months that are partially elapsed (if marked for self-approval 
at the month level) will approve for the non-elapsed weeks 
in that month. 

2. Navigate to the ChannelPlan menu (located to the left of the Window menu); select 
the “Self Approve” option in the TopPlan menu. 

A message box is displayed indicating the rule groups have executed successfully. If 
the message box indicates “success,” the approval process completed successfully. 

Data is automatically committed to the database and the workbook is refreshed. The 
workbook is not automatically saved. 

Measures 

Measure Access 

Self Approve Comment Write 

Wp Self Approve Write 

Wp Self Approve Date Read 
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Measure Calculations 

This chapter provides a summary of specific measure calculations and a summary of 
common, repeated calculations that are contained within the ChannelPlan solution. Some 
measures in ChannelPlan can be calculated one of two ways depending on the specific 
edit made. You can view which calculation is in effect for a measure by right clicking on 
the measure and selecting Show Measure Status after an edit is made but before 
calculating. 
The goal of this chapter is to document some key measure calculations and repeatedly 
used calculations, not to document every calculation for every rule in the solution. 

Commonly Used Calculations 
Measure Type Primary Calculation Method Example 

Wp variance measures Calculated by subtracting the 
designated variance version 
measure from the Wp measure 
and dividing by the Wp measure 

Wp Sales var Ly R% =  
(Wp Sales R – Ly Sales R) / Wp 
Sales R 

Contribution to Product % or 
Contribution to Time % 

Calculated by taking a measure 
at a specific product or time 
period and determining it’s % 
contribution to the highest 
product or time period in the 
workbook 

Sales contribution to Time R % 
(at a week level) = Sales R (at that 
week) / Sales R (at the year) * 100

Specific Measure Calculations 
Units of measure have been removed to simplify the following table. In many instances, 
there are Retail and Unit versions of the measures (for example, Avg Inv R and Avg Inv 
U). Unless noted, the basic calculation is the same for both the retail and unit measures. 

Measure Calculation 

Avg Inv  Sales / TO  

Avg Square Footage Square Footage / number of stores in the aggregate 
location  
= Square Footage at base location 

Avg Store Sales  Sales / Store Count 

Sales per Square Foot Sales  / Square Footage 

TO  Sales  / Avg Inv 

Comp Store Sales  = 0 at base location if store status <> “Comp”, otherwise it 
is = Sales R at base location 
Value is summed to aggregate levels of time and location 
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Measure Calculation 

Non-Comp Store Sales = 0 at base location if store status <> “NonComp”, 
otherwise it is = Sales R at base location 
Value is summed to aggregate levels of time and location 

Comp Store Sales 
Base 

If Store Status = “Comp” for the specific time period, then 
Comp Store Sales Base = Ly Sales R of that same time 
period  
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4 
ChannelPlan Measures List 

The following table contains a complete list of the measures that are delivered with 
TopPlan. Every measure has four components: Role, Version, Metric, and Unit of 
Measure. 

Measure Name Measure Label Measure Description Access 

CCpAvgInvR Cp Avg Inv R Average Inventory Retail Read 

CCpAvgSSlsR Cp Avg Store Sales R Retail Sales value averaged by the number 
of stores 

Read 

CCpAvgSqFtU Cp Avg Square Footage Average Square Feet per channel hierarchy 
member 

Read 

CCpSlscLocRp Cp Sales Contribution to 
Location R % 

The contribution that a Sales Retail value of 
a specific location hierarchy level makes to 
the Sales Retail value at the highest location 
level 

Read 

CCpSlsCmpBsR Cp Comp Store Sales Base R The Approved Plan value representing last 
year Sales value of a store (or aggregation 
of stores) whose status was Comp at the 
time the plan was approved. 

Read 

CCpSlsCmpR Cp Comp Store Sales R Comp Store Sales Retail Value Read 

CCpSlscTmeRp Cp Sales Contribution to 
Time R % 

The contribution that a Sales Retail value of 
a specific product hierarchy level makes to 
the Sales Retail value at the highest product 
level 

Read 

CCpSlsNCmpR Cp Non-Comp Store Sales R Non-Comp Store Sales Retail Value Read 

CCpSlsR Cp Sales R Sales Retail Value Read 

CCpSlsSqFtR Cp Sales per Square Foot R Retail Sales per Square Foot Read 

CCpSqFeetU Cp Square Footage Square Footage applicable to a channel 
hierarchy member 

Read 

CCpStrCtCmpCt Cp Comp Store Count Number of Comp Stores Read 

CCpStrCtCt Cp Store Count Number of Stores Read 

CCpStrCtNCmpCt Cp Non-Comp Store Count Number of Non-Comp Stores Read 

CCpStrStatusTx Cp Store Status  A store's status: comp, non-comp, or closed Read 

CCpTORr Cp TO R The frequency with which inventory value 
is sold and replaced over a stated time 
period 

Read 
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Measure Name Measure Label Measure Description Access 

CFpDemandR FrcPr Demand R Retail Sales Forecasted Demand PreSeason Read 

CFiDemandR FrcIn Demand R Retail Sales Forecasted Demand InSeason Read 

CLyAvgInvR Ly Avg Inv R Average Inventory Retail Read 

CLyAvgSqFtU Ly Avg Square Footage Average Square Feet per channel hierarchy 
member 

Read 

CLyAvgSSlsR Ly Avg Store Sales R Average Store Sales Retail Value Read 

CLySlscLocRp Ly Sales Contribution to 
Location R % 

The contribution that a Sales Retail value of 
a specific location hierarchy level makes to 
the Sales Retail value at the highest location 
level 

Read 

CLySlsCmpR Ly Comp Store Sales R Comp Store Sales Retail Value Read 

CLySlscTmeRp Ly Sales Contribution to 
Time R % 

The contribution that a Sales Retail value of 
a specific product hierarchy level makes to 
the Sales Retail value at the highest product 
level 

Read 

CLySlsNCmpR Ly Non-Comp Store Sales R Non-Comp Store Sales Retail Value Read 

CLySlsR Ly Sales R Last Year Sales Retail Value Read 

CLySlsSqFtR Ly Sales per Square Foot R Retail Sales per Square Foot Read 

CLySlsSqFtR Ly Square Footage Square Footage applicable to a channel 
hierarchy member 

Read 

CLySqFeetU Ly Store Count Last Year Number of Stores Read 

CLyStrCtCmpCt Ly Comp Store Count Number of Comp Stores Read 

CLyStrCtCt Ly Store Count Last Year Number of Stores Read 

CLyStrCtNCmpCt Ly Non-Comp Store Count Number of Non-Comp Stores Read 

CLyStrStatusTx Ly Store Status A store's status: comp, non-comp, or closed Read 

CLyTORr Ly TO R The frequency with which inventory value 
is sold and replaced over a stated time 
period 

Read 

COpAvgInvR Op Avg Inv R Average Inventory Retail Read 

COpAvgSqFtU Op Avg Square Footage Average Square Feet per channel hierarchy 
member 

Read 

COpAvgSSlsR Op Avg Store Sales R Retail Sales value averaged by the number 
of stores 

Read 

COpSlscLocRp Op Sales Contribution to 
Location R % 

The contribution that a Sales Retail value of 
a specific location hierarchy level makes to 
the Sales Retail value at the highest location 
level 

Read 
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Measure Name Measure Label Measure Description Access 

COpSlsCmpBsR Op Comp Store Sales Base R The Approved Plan value representing last 
year Sales value of a store (or aggregationof 
stores) whose status was Comp at the time 
the plan was approved 

Read 

COpSlsCmpR Op Comp Store Sales R Comp Store Sales Retail Value Read 

COpSlscTmeRp Op Sales Contribution to 
Time R % 

The contribution that a Sales Retail value of 
a specific product hierarchy level makes to 
the Sales Retail value at the highest product 
level 

Read 

COpSlsNCmpR Op Non-Comp Store Sales R Non-Comp Store Sales Retail Value Read 

COpSlsR Op Sales R Sales Retail Value Read 

COpSlsSqFtR Op Sales per Square Foot R Retail Sales per Square Foot Read 

COpSqFeetU Op Square Footage Square Footage applicable to a channel 
hierarchy member 

Read 

COpStrCtCmpCt Op Comp Store Count Number of Comp Stores Read 

COpStrCtCt Op Store Count Number of Stores Read 

COpStrCtNCmpCt Op Non-Comp Store Count Number of Non-Comp Stores Read 

COpStrStatusTx Op Store Status  A store's status: comp, non-comp, or closed Read 

COpTORr Op TO R The frequency with which inventory value 
is sold and replaced over a stated time 
period 

Write 

CWpAvgInvR Wp Avg Inv R Average Inventory Retail Read 

CWpAvgInvvLyRp Wp AvgInv var Ly R % Percentage increase or decrease in average 
inventory this year over last year 

Read 

CWpAvgInvvTgRp Wp AvgInv var Tgt R % Percentage increase or decrease in Average 
Inventory value over superior's plan Target 

Read 

CWpAvgSqFtU Wp Avg Square Footage Average Square Feet per channel hierarchy 
member 

Read 

CWpAvgSSlsR Wp Avg Store Sales R Average Store Sales Retail Value Read 

CWpSlfAppB Wp Self Approve Pre-Season Self Approval Flag   
Moves Wp version data to both Op and Cp 
versions 

Write 

CWpSlfAppDteD Wp Self Approve Date Date and time Pre-Season Self Approval 
Flag was set 

Read 

CWpSlfAppTxtTx Wp Self Approve Comment Comments made while approving the last 
plan submitted for approval 

Write 
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Measure Name Measure Label Measure Description Access 

CWpSlscLocRp Wp Sales Contribution to 
Location R % 

The contribution that a Sales Retail value of 
a specific location hierarchy level makes to 
the Sales Retail value at the highest location 
level 

Write 

CWpSlsClosedR Wp Closed Store Sales Sales attributed to stores whose status is set 
to closed 

Read 

CWpSlsCmpBsR Wp Comp Store Sales Base R The last year Sales value of a store (or 
aggregationof stores) whose status is Comp 

Read 

CWpSlsCmpR Wp Comp Store Sales R Comp Store Sales Retail Value Write 

CWpSlsCmpvLyRp Wp Comp Store Sales var Ly 
R % 

Percentage difference between Working 
Plan Comp Store Sales and Last Year Store 
Sales Retail 

Write 

CWpSlscTmeRp Wp Sales Contribution to 
Time R % 

The contribution that a Sales Retail value of 
a specific product hierarchy level makes to 
the Sales Retail value at the highest product 
level 

Read 

CWpSlsNCmpR Wp Non-Comp Store Sales R Non-Comp Store Sales Retail Value Write 

CWpSlsR Wp Sales R Sales Retail Value Write 

CWpSlsSqFtR Wp Sales per Square Foot R Retail Sales per Square Foot Read 

CWpSlsvFpRp Wp Sales var Demand Pre-
Season R % 

Percentage difference between Working 
Plan and Pre-Season Forecast Sales Retail 
Value 

Write 

CWpSlsvFiRp Wp Sales var Demand In-
Season R % 

Percentage difference between Working 
Plan and In-Season Forecast Sales Retail 
Value 

Write 

CWpSlsvLyRp Wp Sales var Ly R % Percentage difference between Working 
Plan and Last Year Sales Retail Value 

Write 

CWpSlsvOpRp Wp Sales var Op R % Percentage difference between Working 
Plan Sales and Original Plan Sales Retail 
Value 

WRite 

CWpSlsvTgRp Wp Sales var Tgt R % Percentage difference between Working 
Plan Sales and Target Sales  Retail Value 

Write 

CWpSqFeetU Wp Square Footage U Square Footage applicable to a channel 
hierarchy member 

Read 

CWpStrClDtD Read 

 

Wp Store Close Date The date a store is closed 

Write in 
Admin 
workbook

CWpStrCtCmpCt Wp Comp Store Count Number of Comp Stores Read 
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Measure Name Measure Label Measure Description Access 

CWpStrCtCt Wp Store Count Number of Stores belonging to the 
dimension being viewed 

Read 

CWpStrCtNCmpCt Wp Non-Comp Store Count Number of Non-Comp Stores Read 

CWpStrOpDtD Read 

 

Wp Store Open Date The date a store is open for business 

Write in 
Admin 
workbook

CWpStrStatusTx Read 

 

Wp Store Status Tx A store's status: comp, non-comp, or closed 

Write in 
Admin 
workbook

CWpTORr Wp TO R The frequency with which inventory value 
is sold and replaced over a stated time 
period 

Write 

MCpAvgInvR TMg Cp Avg Inv R Original Plan(Approved) Average Inventory 
from TopPlan 

Read 

MCpSlsR TMg Cp Sales R Original Plan(Approved) Retail Sales from 
TopPlan 

Read 

MCpTORr TMg Cp TO Rr Original Plan(Approved) Turnover from 
TopPlan 

Read 

MOpAvgInvR TMg Op Avg Inv R Original Plan(Approved) Average Inventory 
from TopPlan 

Read 

MOpSlsR TMg Op Sales R Original Plan(Approved) Retail Sales from 
TopPlan 

Read 

MOpTORr TMg Op TO Rr Original Plan(Approved) Turnover from 
TopPlan 

Read 

MTgAvgInvR TMg Tgt Avg Inv R Target Average Inventory from TopPlan Read 

MTgSlsR TMg Tgt Sales R Target Retail Sales from TopPlan Read 

MTgTORr TMg Tgt TO Rr Target Turnover from TopPlan Read 
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